
 
 
 

Acrobat 7: Basics 
Learning Guide 
 
 
 Why use Acrobat’s PDF format? 

Documents in Acrobat’s Portable Document Format (PDF) can 
easily be viewed or printed from any computer.  PDF documents 
appear to the viewer exactly as the document creator intended – 
regardless of whether the viewer has the same installed fonts and 
programs (or even the same kind of computer) as the creator of the 
document.  PDF is an ideal format for sharing documents such as 
handbooks, forms, and newsletters on your departmental website 
or BlackBoard course site. 
 
 
What’s the difference between Acrobat  
and Adobe Reader? 
Adobe Reader (formerly called Acrobat Reader) is free software 
that allows you to view & print any document in PDF format, 
however it cannot create PDF documents.  Acrobat, on the other 
hand, can both read and create PDF documents. 
 
 
How does Acrobat work? 
Unlike other applications, you cannot use Acrobat to create new 
documents.  You will use Acrobat to copy and convert any existing 
document into the PDF format.   
 
 
How do I convert documents to PDF format? 
Acrobat’s… Allows you to… 
PDF Maker Convert any Microsoft Office document into a PDF. 

You can automatically create bookmarks and set 
the security for your new PDF document.  

Adobe PDF Convert any document to PDF format. With a PDF 
document created using the Adobe PDF printer, 
you will need to create bookmarks and set the 
security yourself.  
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Converting a Word document to PDF format 
• Open up the Word document that you wish to convert into a 

PDF.  
• From the Adobe PDF menu, select Convert to Adobe PDF. 
 

 
 

• Acrobat will scan your document and prepare it for conversion 
to PDF format. 

• The Save Adobe PDF File As window will appear.  
• Navigate to the folder where you wish to save your new PDF 

document.   
• In the box labeled File name, type a descriptive name for your 

PDF. 
• Click on the button labeled Save. 
 

 
 
 

Tip: After you select the folder that will contain your new PDF, 
make sure that you can see the contents of the folder you meant to 
choose before clicking Save. 
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• While your Word document is being converted into a PDF, the 
Acrobat PDFMaker window will appear to show how far 
Acrobat has progressed with the conversion process. 

 

 
 
• Once your document has been converted to PDF and saved, 

Acrobat will display your newly-created PDF document on the 
screen. 

 
 

 
Creating bookmarks in your document 
Although it is possible to navigate through a PDF document simply 
by scrolling, bookmarks make it easier for your colleagues to use 
your document.  By clicking on a bookmark, a reader can view the 
page or document section that you have linked to the bookmark. 
 
Opening your new document in Acrobat 
• From the Start menu, select the All Programs submenu. 
• From the All Programs submenu, select Adobe Acrobat 7.0 

Professional. 
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• From the File menu, select Open. 
• Navigate to the folder where you saved your PDF document.   
• Click on the name of your PDF document to select it. 
• Click on the button labeled Open. 
 

 
 
 

Creating bookmarks 
To create a bookmark in your PDF: 
• Click on the tab labeled Bookmarks at the far left of the 

Acrobat window to display the Navigation pane.  
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• Scroll to the place in your document where you wish to insert a 
bookmark. 

• On the Navigation pane, click on the button labeled Options. 
• From the menu that appears, select New Bookmark. 
 

 
 

• Acrobat will create a new, untitled bookmark in the 
Bookmarks area. 

• In the box labeled Untitled, type a descriptive name for your 
new bookmark. 

 

 
 
• Type the Enter key on your keyboard. 
• Use the previously described techniques to add additional 

bookmarks to your document. 
 

Tip: Naming bookmarks 
When naming a bookmark, choose a name that will provide some 
information about the content that you bookmarked.  Just as a 
vague chapter title in a book’s table of contents can prevent you 
from reading a very interesting chapter, a vague bookmark title 
can deter readers of your document from investigating a section of 
your document. 
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Tip: Bookmarking multiple sections on a page 
You can bookmark multiple areas on a page to allow your readers 
easier access to your content.  To bookmark a part of a page:  
• Scroll through your document so the area you wish to 

bookmark is displayed as close to the top of the Acrobat 
window as possible.   

• Create and title your bookmark. 
• When a reader clicks on the bookmark you just created, 

Acrobat will display the section of your page just as it 
appeared when you created the bookmark. 

 
 
Tip: Automatic bookmarks 
When you create a PDF document using PDFMaker, Acrobat will 
use Word’s style headings to create bookmarks.  If you have styled 
your text using the formats labeled Heading 1, Heading 2, etc. in 
Word’s Styles and Formatting task pane, Acrobat will create 
bookmarks for your content automatically. 
 
 
Moving bookmarks 
Acrobat allows you to reorder your bookmarks by moving them to 
a new location in the bookmark pane.  You can designate a 
bookmark to be part of a larger section by moving it beneath the 
bookmark that designates the beginning of the section.  To move a 
bookmark: 
• Place the cursor over your bookmark’s document icon. 
• Drag the bookmark to its new location. 
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Renaming an existing bookmark 
Once a bookmark has been created, you can easily change its 
name.  To change the name of your bookmark: 
• Right-click on the bookmark whose name you wish to change. 
• From the menu that appears, select Rename.   
 

 
 

• A box will appear around the name of the bookmark. 
• Type the new name for your bookmark. 
• Type the Enter key on your keyboard to confirm the name 

change that you made. 
 
 
Editing the destination of an existing bookmark 
Sometimes, you will need to change the location to which a 
bookmark points.  To change a bookmark’s destination: 
• Scroll through the document until the new destination for your 

bookmark appears at the very top of the document window. 
• Right-click on the bookmark you wish to edit. 
• From the menu that appears, select Set Destination. 
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• The Adobe Acrobat window will appear asking you to 
confirm the bookmark’s destination will be set to the current 
location. 

• Click on the button labeled Yes. 
 

 
 
 
 
Editing a PDF document 
Once you have converted a document to PDF format, you can 
make minor changes to that document.  Acrobat provides tools that 
allow you to edit text within your document. 
 
Editing text within a PDF document 
Although Acrobat is not the best tool for making extensive 
revisions to your document, you can easily make changes within 
each line of text.  To edit a line of text: 
• Scroll through your document so that you can see the line you 

wish to edit. 
• From the Tools menu, select the Advanced Editing submenu. 
• From the Advanced Editing submenu, select Show Advanced 

Editing Toolbar.  
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• The Advanced Editing toolbar will appear.  
• From the toolbar, click on the TouchUp Text Tool button.  
 

 
 

• Click on the line whose text you wish to edit.   
• A box will appear around the text that you have chosen to edit. 
 

 
 
• Once the box appears, you can edit the text on each line just as 

you would edit text in a Word document. 
• Once you have finished making changes to your text, click 

anywhere outside of the box to deselect it. 
 
 
 
Protecting your PDF document 
Generally, when you post a PDF document on your website, you 
will want to make the document widely available but prevent 
others from making changes to it.  Acrobat provides security tools 
that can protect your document from unauthorized changes and 
your content from theft. 
 
Setting document permissions 
When you set permissions, you are restricting access to your 
document.  The more restrictive you set your permissions, the 
more secure your document will be.  Unfortunately, as your 
document becomes more secure, it also becomes less useful for 
your website’s visitors.  When setting permissions, try to give your 
users all of the capabilities they will need without giving them too 
much control.  To set permissions to your PDF: 
• From the File menu, select Document Properties. 
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• The Document Properties window will appear. 
 

 
 
• Click on the tab labeled Security. 
• In the Document Security area, click on the down-facing 

arrow next to the box labeled Security Method. 
• From the menu that appears, select Password Security. 
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• The Password Security-Settings window will appear.  
• In the Permissions area, click to place a checkmark in the box 

labeled Use a password to restrict printing and editing of 
the document and its security settings. 
 

 
 

• In the box labeled Permissions Password, type a password 
that users must enter to change the security settings in your 
document.  

• To permit users to print your document, click on the down-
facing arrow next to the box labeled Printing Allowed. 

o To permit users to print only a low-quality version of 
your document, select Low Resolution from the menu 
that appears. 

o To permit users to print your document at high quality, 
select High Resolution. 

 

 
 
• To permit users to make changes to your document: 

o Click on the down-facing arrow next to the box labeled 
Changes Allowed. 
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• From the menu that appears, select the item that describes the 
changes you wish to allow your users to make. 

 
 

To allow users to…. Select…. 
Add pages to and remove pages 
from your document 

Inserting, deleting, 
and rotating pages 

Fill out and print an Acrobat form 
that you’ve added to your 
document 

Filling in form fields 
and signing 

Review and comment on a draft 
of a document 

Commenting, filling in 
form fields, and 
signing 

Do any of these Any except extracting 
pages 

 
• To allow document users to copy content from the document: 

o Click to place a checkmark in the box labeled Enable 
copying of text, images, and other content. 

 

 
 
• On the Password Security-Setting window, click on the 

button labeled OK to save the permissions you chose for your 
document. 

• On the Document Properties window, click on the button 
labeled OK to apply the security restrictions to your PDF. 

 
Tip: Allowing users to copy content from your document means 
that they will be able to reuse your content in documents of their 
own.  Unless you want to allow this, don’t place a checkmark in 
the box labeled Enable! 
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Setting a password for document access 
For extra security, you can establish a password that will be 
required when users attempt to open your document.  Setting such 
a password will prevent unauthorized users from reading your 
document, but will also frustrate your users by requiring them to 
remember yet another password.  To set up a document access 
password: 
• From the Password Security – Settings window, click to place 

a checkmark in the box labeled Require a password to open 
the document. 

• In the box labeled Document Open Password, type the 
password that will be required for access to your document. 

 

 
 

• Click on the button labeled OK. 
• The Adobe Acrobat Confirm Document Open Password 

window will appear. 
• In the box labeled Document Open Password, re-type the 

password you selected to open your PDF. 
• Click on the button labeled OK to apply the security 

restrictions to your PDF. 
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Converting a paper document to PDF 
Until recently, the simplest way to distribute a paper document was 
by using a copier and campus mail.  While that may still be the 
easiest way in some situations, it may sometimes be more efficient 
to convert that document to PDF format so that it can be posted on 
your departmental website or Blackboard course site.   
 
Beginning your scan 
• Place your document on the scanner glass. 
• From the File menu, select the Create PDF submenu. 
• From the Create PDF submenu, select From Scanner. 
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• The Create PDF from Scanner window will appear.  
• Click on the down-facing arrow next to the box labeled 

Scanner. 
• From the menu that appears, select the name of your scanner 

(for example, Epson Twain 5). 
• At the bottom of the Create PDF from Scanner window, click 

on the button labeled Scan. 
 

 
 

• Your scanner will warm up and pre-scan your document. 
• In most cases, the software that controls your scanner will 

launch and its window will appear on your screen. 
• To adjust the resolution of your scan: 

o Click on the button labeled Settings.  
o Select the Resolution of your scan. 
o Click on the button labeled Scan to begin scanning. 

 
Tip:  If you are asked to select a resolution for your scan, pick one 
that is approximately one-third of the resolution of your printer.  
Use this table as your guide. 
 

When viewing/printing on…. Scan at…. 
The screen 50-100 dpi 
A 300 dpi laser printer 100 dpi 
A 600 dpi laser printer 200 dpi 
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• Once Acrobat has finished scanning, the Acrobat Scan Plug-
in window will appear. 

• Click the button labeled Done. 
 

 
 
• Acrobat will display your scanned document. 
 
 
Scanning a multi-page document 
If your document has more than one page, you can still scan all of 
the pages into a single PDF.  Once you’ve scanned the first page of 
your document: 
• Remove the first page of your document from the scanner, and 

place the second page on the scanner glass. 
• From the Acrobat Scan Plug-in window, click on the button 

labeled Next to scan and append the second page of your 
document. 

 

 
 
• To scan additional pages, follow this process: 

o Remove the page you just scanned from the scanner.   
o Place the document’s next page on the scanner glass. 
o From the Acrobat Scan Plug-in window, click on the 

button labeled Next. 
• When you have finished scanning all of your pages, and the 

Acrobat Scan Plug-in window re-appears, click on the button 
labeled Done. 
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Saving your document 
Once you’ve scanned every page in your document, you can then 
save your new PDF document so that it can be shared or posted on 
your website.  To save your document: 
• From the File menu, choose Save. 
• The Save As window will appear.  
• Navigate to the location where you wish to save your 

document.  
• Click on the button labeled Save.  
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